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Section 1: Introduction 
This manual covers the installation, operation, and maintenance of the Marksman© Net Ink
Jet Printing System. Also included is a troubleshooting section and parts list.
The Marksman Net is a single print head controller that can be used on any of the Pro-
Series print heads. A system can range from a single head application to a multiple head
print station controlled from a PC connected to the Marksman Net via an Ethernet connec-
tion and running BoxWriter Net software. BoxWriter software is required to configure and
control the Marksman Net. 
The system, as sold, is configured for a single head application. Each controller drives one
print head. The controllers can be daisy-chained together with an additional cable to share
encoder and photocell signals. In addition, the BoxWriter© Net Software allows the Marks-
man© Net controllers to be accessed and controlled via one piece of software. If more
devices are required to be connected to the network, consult your network administrator for
proper cables and hubs. A Marksman© Hub can be placed on the same network to allow
for connection to an Alarm Beacon/Strobe (for error indications) or other peripheral devices
(such as a scanner).
Standard message mode vs. Single message mode: The system can be configured for two
different modes, Standard mode or Single message mode. The default mode is the stan-
dard mode in which all the messages are downloaded and stored on the Marksman Net.
This mode works fine for users that do not foresee exceeding the Marksman Net storage
capability. If the application requires over 200 messages and/or several logos per Marks-
man Net, then the Single message mode would need to be selected. In this mode when
the message is started, it is downloaded to the Marksman Net and all others are erased so
that there is only one message on the Marksman Net. Therefore, the number of messages
is limited only by the size of the hard dive of the PC.

NOTE: If BoxWriter is to be used to control Marksman Nets, it must stay connected to
them. Database errors could occur if the software is routinely disconnected.

System Requirements for BoxWriter© Net Software 
PC with 300MHz or higher
Memory: 128MB
Hard Disk: 1.5GB
Network Adaptor
OS: Windows XP

Software Installation 
Insert the BoxWriter© Net Software
installation disk into the computer and go
to the Start menu. Select Run, type
"D:\BwNetSetup" (without quotation
marks, where "D" is the applicable drive
letter) and click OK. Or, go to the CD
drive, select the BwNetSetup icon and
the appropriate files will be loaded.
Select the language of the install pro-
gram only. (After the program has been
installed, refer to "Section 6:BoxWriter©
Net, Security, Translate" to select a lan-
guage other than English for the Box-
Writer software.)
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When the setup program is started, the Nullsoft® installation wizard will guide you through
the installation process. You will be instructed to close all other programs and to agree or
disagree with the software license. (If you disagree with the license, the software will not be
installed.)
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If the installation is successful, the user will be prompted with the default username and
password. This is needed to log in to the Marksman Net Controller.

Username: ADMIN
Password: FOXJET

NOTE: Usernames and passwords are not case sensitive.

If a database was already installed (in the case of an upgrade, or reinstallation) the user will
be prompted with the following dialog. Choosing "No" will result in all previously saved data
being erased. 
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Section 2: Safety
Following is a list of safety symbols and their meanings, which will be found throughout this
manual. Pay attention to these symbols where they appear in the manual.

Wear safety goggles when performing the procedure described!

Caution or Warning! Denotes possible personal injury and/or damage to the equip-
ment.

Caution or Warning! Denotes possible personal injury and/or equipment damage
due to electrical hazard.

NOTE:

Only trained personnel should operate and service the equipment.

It is extremely important to:
• Clean up all ink spills with the appropriate conditioners immediately and dispose of all

waste according to local and state regulations.
• Wear safety glasses and protective clothing, including gloves, when handling all inks

and conditioners.
• Store inks and conditioners under the recommended conditions found on the MSDS.

!
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Section 3: System Components 

1

2

3
4

5

6

7

8

9

10

5

 1  Marksman Net Controller
 2  ProSeries Print Head
 3  Conveyor
 4  Product
 5  Print System Bracketry
 6  Encoder
 7  Ink Supply
 8  Photosensor
 9  Vacuum Waste Collector Bottle
10 Encoder Cable
11 Alarm Beacon (Strobe)
12 Cordset, Encoder, Shared Connection

11

13
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The Marksman© Net Ink Jet System is available with the following components, options
and service kits: 

Part Number Description

Integrated Print Head
2464008 ProSeries 192, Integrated w/APS, V300
2464023 ProSeries 192, Integrated w/APS, ScanTrue II®
2464009 ProSeries 352, Integrated w/APS, V300
2464034 ProSeries 384, Integrated w/APS, ScanTrue II®
2464236 ProSeries 384, Modular w/APS, ScanTrue II®
2464025 ProSeries 768, Integrated w/APS, ScanTrue II®
2464232 ProSeries 768, Modular, w/APS, ScanTrue II®

2466025D ProSeries NP192 Print System Assembly, Domestic
2466025E ProSeries NP192 Print System Assembly, European
2466026D ProSeries NP192 Modular Print System Assembly, Domestic
2466026E ProSeries NP192 Modular Print System Assembly, European
2464228 ProSeries AlphaCoder, AlphaMark
2464238 ProSeries AlphaCoder, ScanTrue II®

Controller Assembly
2464325 Controller Assembly, ProSeries, Marksman© Net, Domestic
2464326 Controller Assembly, ProSeries, Marksman© Net, European

Print Head Bracketry
2464550 Conveyor Mount Bracket
2464552 Retracting Bracket for 96/192 Print Head
2464553 Pivot Bracket
2464561 X-Y Axis Linear Adjustment, Tool-Less Bracket
2464562 Conveyor Mount/Roller Bracket for 768 Print Head
2464563 Floor Mount Bracket Kit
2464564 Conveyor Mount/Roller Bracket for 384/352 Print Head
2464565 Conveyor Mounting Bracket with Integrated Guide Rails for 384/768 Print Head

Encoder, Photosensor, Alarm Beacon
5760820-IJ Encoder, 2400 ppr (includes bracketry)

2465224 Photosensor, ProSeries
2465504 Alarm Beacon (Strobe)

Cabling
5760150-010 Cordset, System Configuration, DB9, 10 Ft. (One is included with the Controller.)

5760256 Cable, Ethernet Crossover, 10 Ft. (One is included with the Controller.)
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Controller

Power Indicator Light
• Green indicates power is on.
Activity
• Green LED, flashes on and off in normal operation.
Error Indicator Light, Red
• Solid light indicates low ink or the ink collection bottle needs to be changed.
• Flashing light indicates any error (other than low ink) that prevents the system from

printing.

Strobe
(DB9F)

Power

Error
Indicator

ActivityPower
Indicator

Serial Port
(DB9F)

Ethernet Port

Print Head
Connection
(not shown)

Daisy
Chain Out

Encoder In/
Daisy Chain In
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Integrated Print Head

INK BOTTLE

WASTE BOTTLE

INK SYSTEM

PRINT HEAD
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Bracketry
Bracketry is the structure that supports the controller, print system and other accessories.
This manual details instructions for mounting all system components to a conveyor. Other
mounting options for the controller and print system include the floor mount and the retract-
ing bracket. Assembly instructions are included with parts kits.

Retracting Bracket

Conveyor Mount

Floor Mount
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Photosensor
The photosensor is both a light source and a sensor. It emits light and detects the arrival of
a product when the product reflects the light source back to the sensor. The sensor then
sends a signal to the controller to start the printing cycle.

Encoder
The encoder assembly provides conveyor line
speed information to the controller. 
In addition to providing line speed information,
the encoder also allows automatic disabling of
printing when the line stops.
The Marksman© Net System uses a 5000 ppr
open collector output encoder. The wheel is
sized to provide the correct timing inputs to allow
the print heads to print from 150 to 300 dpi.

Ink 
Ink is supplied via 500 mL plastic containers. Ink types include glycol-oil based VersaP-
rint™ V300 for general purpose printing and ScanTrue® II pigmented ink for high edge def-
inition printing. Both inks are formulated for use on porous substrates.

NOTE: Check the label on the Print Head for correct ink type.

NOTE: VersaPrint™ V300 and ScanTrue® II inks are not miscible. Do NOT mix the inks.

Waste Bottle
The APS includes a Waste Collection Bottle mounted on the rear of the Print Head assem-
bly. This bottle must be changed when full to prevent improper operation of the system.
Instructions for waste disposal are on the collection bottle.

ENCODER ASSEMBLY
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Section 4: Installation
The figure below illustrates a typical conveyor-mounted install. (Cables and ink lines are
not shown.)

Materials Required for Installation
You will need the following items:
• Lint-free wipes
• Safety goggles
• Level
• Tape measure

Use appropriate safety equipment and procedures. Leave print heads in their shipping car-
tons until all bracketry is in place and tightened down.
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System Installation Overview
NOTE: The following steps give an overview of the procedure to properly install the Marks-
man© Net print system. Refer to the appropriate section for details.

1. Carefully plan the mounting location of the equipment. Keep in mind bracketry hard-
ware location and printer equipment size.

2. Remove equipment from packaging.
3. Assemble all bracketry to the floor, conveyor, or other bracketry per bracketry installa-

tion section.
4. Mount the print system to its appropriate bracketry. Do not connect to power outlet.
5. Assemble the optional retracting bracket to each print head, if applicable.
6. Mount the print head(s) to their appropriate bracketry and in the approximate location

relative to the carton.
7. Mount the photosensor, optional bracketry, and optional encoder per procedure.

CAUTION: Remove the print head Ship Cap prior to operating the Print Heads.

Installing Bracketry
This section shows controller bracketry mounted to a conveyor. This is the most common
mounting method, and the most stable, as all bracketry is bolted directly to the conveyor.
Detailed assembly instructions are included with the parts kit. 
Other mounting options, including parts kit numbers, are listed in Section 3, System Com-
ponents.
Corner brackets are attached to aluminum bars as shown.

!

ATTACHING
CORNER

BRACKET

Single T-nut

Corner Bracket
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Mounting the Print System
Unpack the print head just before mounting to the bracketry. 
Attach the print head to the bracketry with a print head mounting bracket.
The print head must be mounted in close proximity to the product. To maintain consistent
print, the head should be mounted no more than 1/8" from the substrate. An optional
retracting bracket is available to mount the head and control the distance from the head to
the substrate. The retracting bracket allows the head to bump the product and retract as
required to maintain a consistent throw distance. (See "Section 3: System Components" for
bracketry options.)

NOTE: Install optional retracting bracket kit on the print head prior to mounting the print
head to the conveyor bracket.

It may be necessary to vertically adjust each bracket's horizontal bar later to fine-tune mes-
sage placement. This is especially true when using multiple print heads, as message lines
will need to be synchronized with each other.

NOTE: When adjusting the horizontal bar or print head mounting bracket, always support
the print head with your hand to keep it from falling forward onto the conveyor.

NOTE: The ProSeries print heads work on gravity and capillary ink feed, internal in the
print head. The head must be mounted in a level position from front to back to prevent leak-
age.
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Setting Up the Print Head
The Pro/Classic Series print heads are mounted using the 10-32 tapped holes on the right
or left side of the Ink System bottom case. The print head angle can be set between 0° and
90°. Common settings are shown below. 

To adjust the head to its correct angle:
1. Loosen the two set screws (1/8" hex head) on the print head side of the head mount.
2. Rotate the head to the desired angle.
3. Secure the set screws. 

Mounting the Photosensor
The product detect Photocell can be mounted on either side of the print head, depending
on the direction of print. Remove the plugs or set screws (3/32" hex head) in the photocell
mounting holes, then attach the Photocell Mounting Bracket with the 10-32 x 1/2" screws
provided with the bracket.

90° 32° - 39°

352 1.9”,
384 2” & 768 4”

Print Heads

192 1”
Print Head

96 3/4”
Print Head

27°

PRINTHEAD

INK SYSTEM

PHOTOCELL
MOUNTING

HOLES PRINTHEAD
MOUNTING

HOLES

LOOSEN SET
SCREWS TO

ROTATE HEAD

HEAD MOUNT

DO NOT ADJUST THE
SCREWS ON THE INK
SYSTEM SIDE OF THE
HEAD MOUNT.
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Ship Caps

CAUTION: Do not operate APS Print Heads with the Print Head Ship Cap installed! Oper-
ating a closed system can cause a siphoning effect which can drain the ink supply. 

96, 192 and 352 Print Heads:
Remove the Print Head Ship Cap by squeez-
ing the front of the side extensions together
until the back releases. (See illustration at
right.)
When replacing the Print Head Ship Cap, take
care to align the rubber tips on the back of the
cover with the rub buttons on the face of the
print head.

384/768 Print Head
Loosen the two thumbscrews
and remove the Ship Cap.
(See illustration at right.)

NOTE: If you place the Print Head Ship Cap on a hot print head and do not fasten it
securely, the print head will weep ink until the head has cooled down. 

NOTE: Ink may accumulate behind the ship cap during shipping.

!

SIDE
EXTENSIONS

SQUEEZE TO
REMOVE

RUB
BUTTON

THUMBSCREWS

SHIP CAP
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Open the Reservoir
Vent Cap and Install
the Filter. Remove the
Reservoir Ship Cap
and Install the Ink Bot-
tle. Save caps in a zip-
lock bag for future use. 

CAUTION: Do not
over-tighten the ink
bottle when screwing
into the Reservoir.
Over-tightening will
damage the Reservoir.

The Encoder
The encoder uses a wheel
that rolls against the con-
veyor line to track the speed.
It sends a signal to the con-
troller, which makes adjust-
ments for reported changes in
the line speed.
It is not necessary to install
the encoder immediately adja-
cent to the print heads. It is
more important to place it
where it will accurately mea-
sure the speed of the con-
veyor. Install it in contact with
the conveyor, or with a wheel
or roller moving the same
speed as the conveyor. 
The encoder's mounting
bracket is spring-loaded.
Adjust the spring collar to
ensure that the encoder main-
tains stable contact with the
conveyor.

CAUTION:   Do not jam the encoder wheel against the surface of the conveyor. A radial
force of over 40 lbs. will reduce the life of the bearings. 

INK
BOTTLE

RESERVOIR
SHIP CAP

FILTER

VENT
CAP

PRIME BUTTON

!

Spring

Mounting
Bracket

Encoder
 Wheel

Conveyor

Out to Controller

Mounting Bracket
Shaft

Encoder

ENCODER
ASSEMBLY

!
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Electrical Cable Connections

Single Head System:

NOTES:

* Customer Supplied Equipment

** Encoder: To Controller "ENCODER INPUT"

OPTIONAL STROBE

CONTROLLER PRINT
SYSTEM

ENCODER **

ETHERNET CABLE

POWER

COMPUTER *



 Section 4: InstallationBoxWriter Net Software

Page 20 2464-308 User Manual Rev F, Version 3.54

Multiple Head System with Optional Marksman© Hub: 

NOTES:

* Customer Supplied Equipment

** Encoder: To Controller "ENCODER INPUT"

*** Encoder Cordset (shared): From the master Controller (the one with the Encoder
attached) "ENCODER OUTPUT" to the slave Controller "ENCODER INPUT"

OPTIONAL STROBE

CONTROLLER PRINT
SYSTEM

ENCODER **

PHOTO-
SENSOR

PRINT HEAD CABLE

PRINT
SYSTEM

CONTROLLER

POWER
SUPPLY

COMPUTER *

ETHERNET
HUB *

POWER
SUPPLY

ENCODER CORDSET ***

OPTIONAL STROBE
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Views

INPUT FROM
CONTROLLER

PHOTOCELL

PRINTHEAD
ROTATION

PURGE

POWER FROM
CONTROLLER

COM 1

BACK VIEW OF PRINT SYSTEM BACK VIEW OF CONTROLLER

POWER

ENCODER
OUTPUT

ENCODER
INPUT

OUTPUT TO
PRINT HEAD

ETHERNET

AUXILIARY
PORT

P
O

W
E

R

A
C

TI
V

IT
Y

M
A

LF
U

N
C

TI
O

N
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Priming the Print Heads

NOTE: The system will not prime either manually or automatically if there is a low ink indi-
cation. Low ink indication is caused by either low ink in the reservoir or full ink in the waste
collection bottle.

Manual Prime

NOTE: Place a wipe in front of the maintenance plate to catch excessive ink.

A manual prime can be accomplished by depressing the push-button switch on the rear of
the ink system housing. Pressing and holding the button for longer than one second will
start the pump for a manual prime. It will continue to run as long as the button is depressed,
or up to five seconds. If additional priming is required, release and press the button again.

Pressing for less than 0.5 seconds will initiate a maintenance cycle. If the system has
started a maintenance cycle and the button is pressed, the manual prime will not operate.
(The Priming Sequence and the Vacuum Cycle are less than 10 seconds long.)

APS Cycle

The APS (Automatic Priming System) cycle is a means for re-priming channels in the head
if some are missing. The APS system does this by using a priming pump to force ink out of
the channels and a vacuum pump and collection bottle to collect the ink waste. The APS
cycle can be manually started by momentarily pressing the prime button.

NOTE: The system may not print during an APS cycle or manual prime.   
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Print Head Control of APS

Print Head control of the APS (Automatic Priming System) cycle is accomplished by a pro-
grammed timing interval set by the user at the print head (each head, if more then one is
used). It can be set to run as often as necessary, from once every 2 hours to once every 18
hours for the UJII heads; or from once every hour to once every 12 hours for the graphic
heads. The default setting is once every 4 hours (Switch Setting 2 for a UJII head or Switch
Setting C for a graphics head). The interval can be adjusted by means of a rotary switch
(Programmable Timer) mounted on the APS Controller PCB. (See the illustration below.)
See the following Table for the hour interval for each setting of programmable timer.

The priming sequence will perform three separate consecutive primes of approximately
four milliseconds each. The required time for the priming sequence is less than five sec-
onds, with an additional 20 seconds for the vacuum cycle. As with pervious Trident print
heads, printing cannot occur during the priming sequence.

 0= No APS UJII Heads Graphics Heads 

Switch 
Setting 

0 1 2 3 4 5 6 7 8 9 A B C D E F 

Interval 
(Hours) 

0 2 4 6 8 10 12 14 16 18 1 2 4 6 8 12 

Timing Interval Settings

APS View for Pro/Classic Series Print Heads

LED

DEFAULT
SET TO 2

(4 HOURS)

ROTARY
SWITCH

REMOVE PLUG TO
EXPOSE THE

ROTARY SWITCH
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Auxiliary Photocell Input

An Auxiliary Photocell input is available to insure a print cycle is not missed during the
automatic priming sequence. Connecting the Auxiliary Photocell will retard a prime
sequence until there is enough time to complete the sequence without missing a print
cycle. The default delay setting is three (3) seconds after the product passes the photocell.
Multiple heads can share the Auxiliary Photocell by using the Photocell "Y" Cable. To
change the default setting, perform the following steps:
1. Insure that the rotary switch is not in the "0" position.
2. Place a box in front of the photocell.
3. While the photocell is on, set the rotary switch to 0.
4. When the LED stays illuminated continuously, set the rotary switch to a new number (1

through F) representing the number of seconds (1 through 15) you want to delay. Note:
"0" is not an available user setting.

5. Press and hold the Prime button until the LED starts flashing.
6. Release the Prime button.
7. Remove the box from in front of the photocell.
8. Set the rotary switch back to the desired hour setting.
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Section 5: Getting Started
The Marksman© Net BoxWriter© Software provides a windows graphical user interface to
a Marksman© Net Controller. The main dialog for the control application is shown below:

To log on, click the "Unlock" icon, then enter the Username and
Password. (Note: Usernames and Passwords are not case sensi-
tive.)

Username: ADMIN
Password: FOXJET

The menu tree to the right shows all the menus and sub-menu
options available from within the control application. 

Menu options are configurable and may be unavailable for opera-
tors with limited access. The operator must have administrative
privileges to access all menu options.

The operator may also use the tool bar for quick access to the
Start, Stop, Resume, Idle, Edit, Login and Logout menu selec-
tions.

Marksman© Hub: A green icon indicates that the device Hub is
connected; a red icon indicates that the device Hub is not con-
nected; and a gray icon indicates that the Hub is disabled.

Production Line: The production line name is selected and viewed
by selecting the tabbed folders. The production line configuration
provides for a means of grouping print heads. Up to two produc-
tion lines can be created and configured. 

Line Speed: Line speed is the conveyor speed that the master
head is set at.

Marksman© Menu Tree 
 
Operate 

- Start 
- Stop 
- Resume 
- Idle 
- Print Test Pattern 
- Edit 
- Change User 

Elements 
- Change Counts 
- Exit 
View 
- Printer Report 
- Scan Report 
- Diagnostic Dialog 
- Preview 
- Refresh 
- Zoom 
Configure 
- Print Heads 
- Production Line 
- System 

- Barcode 
Parameters 

- Date/Time Codes 
- Shift Codes 
- Dynamic Table 
- General Settings 
- Strobe 

Security 
- Users 
- Group Options 
- Login 
- Logout 

Help 
- About 

- Firmware 
- Translate 
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Panel: The panel name indicates a specific
side of a rectangular cube representing the
product container. Each of the six panel
names may be utilized to aid in describing
the physical location of a print head in rela-
tion to the product. 

Head: The print head name indicates a
user-defined alphanumeric name associ-
ated with a physical print head. Up to eight
print heads may be defined. Each print
head name must be unique to the system.

Task: A task refers to one to six panels that are to be printed together as a label.

Count: The count indicates the number of times that a task has been printed.

Image State: The image state indicates the current image status for a task. The Image
State may be Running, Paused, Idle or Stopped.

Status Message: The status message displays messages pertaining to the print head sta-
tus. A status message may include one of the following: OK, Low Ink, Out of Ink, Low
Temp, or Voltage Error.
The system will not print if the status message is: "Out of Ink," "Low Temp" or "Voltage
Error."

Status Line: The status line is used to display other system messages and system status.
The name of the user currently logged in is also shown.

Top

Left Front/Back Right

Bottom
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Section 6: BoxWriter© Net

Configuration

Production Line Configuration

The production line configuration allows for grouping of settings that relate to a particular
setup. Select Configure, then select Production Line from the menu. To edit a line, select
it and click Edit; or double-click the line. 
Add: The Add button allows for
the addition of up to eight pro-
duction lines.
Delete: The Delete button allows
for the removal of a production
line from the configuration. All
messages/tasks created for this
production line will be deleted.
Description: The description
field is used to help define the
production line.
Single Message Mode: This
mode will send only the current
message to be printed to the
Marksman Net. This is beneficial
when the number of messages
used exceeds the storage capability of the MK Net.

Fixed Scanner 

This group defines the parameters for
a fixed scanner that may be con-
nected to the Marksman© Hub. The
data is stored under the Scan Report.
(See View Scan Report" later in this
section.)
No Read String: The No Read String
must match the No Read string that is
transmitted from the fixed scanner.
Consecutive No Reads: The Consec-
utive No Reads field is used to per-
form a quality check on barcodes that
are printed. This value determines the
maximum number of consecutive No
Reads that may be transmitted by a
fixed scanner. The printing will be
stopped upon reaching the maximum
value.
Reset on Task Start: The Reset on
Task Start check box determines that
the current number of consecutive No
Reads will be reset to zero upon a
task start operation. 
Reset Counts if Re-starting Task: If this box is checked, counts will be reset to zero when
re-starting the task through the Serial Port.
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Hand Scanner

This group defines the parameters for parsing the data stream transmitted by a hand scan-
ner. The data transmitted by the hand scanner must contain a valid task name in order to
allow the task to start.

Buffer Offset: The Buffer Offset value determines the number of characters to offset into
the buffer as transmitted by the hand scanner.

Data Length: The Data Length value determines the number of characters to extract from
the data buffer that will form a task name. 

Requires login: Check this option if a user is required to be logged into the system before
the scanner can be used to start a Task.

Marksman© Hub:

The Marksman© Hub may be connected to the Marksman© Net through a TCP/IP connec-
tion. The device provides additional interface methods such as serial ports. A proper IP
address must be entered and the Enabled field selected to connect to the device. The main
dialog screen will display a green LED when communicating with the device.

IP Address: The IP Address dialog contains the IP address of the Marksman© Hub.

Enabled: The Enabled button determines if a connection to a Marksman© Hub should be
attempted. Click the button to toggle the option between enabled and disabled.

Serial Port: Select the appropriate button to
edit the setup parameters for a serial port
on the Marksman© Hub. The available
properties for the serial ports are shown in
the Serial Settings dialog box.

Each of the properties may be selected
using the corresponding drop-down menu
choices. When selections are complete,
click Apply. The default selections are
shown in the screen at right.

Baud: The Baud option determines the
speed of the transferred data and may be
set to 9600, 19200, 38400, 57600 or
115200.

Parity: Parity determines the type of parity
bit to be used. It may be set to None, Odd
or Even. 

Data Bits: Data Bits determines the number
of data bits used. It may be set to 7 or 8.

Stop Bits: Stop Bits determines the number of stop bits to be used: 1 or 2. 

Device Type: Select a device that is going to be attached to the serial port of the Hub: Hand
Scanner, Fixed Scanner or Remote/PC. This tells the computer what to do with the string of
information when it is received.
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Serial Download Port

Select the port to be used to send the data out if it is required to be transmitted to a device
at the start of each task. The data is entered through the Editor Task properties.

APS Settings

Interval (hours) is the inter-
val in hours at which the
heads on the production line
will perform an APS func-
tion. (The other settings
listed are for information
only.) APS can be disabled
by selecting the Disable
box.

NOTE: When an APS cycle
is performed, the system
will not print until the cycle is
complete.

Print Head Configuration

Select Configure, then select Print
Heads from the menu. Select a line,
then select a panel and click on a head.
A head may be added or removed by
clicking the appropriate Add/Remove
button. To edit a head, select it and click
Edit; or double-click it.

("New Heads" will only show up if there
are un-used Heads/Nets available.)
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Sync. settings: Allows the operator to
select what information to send to the Net
at start-up. This will prevent the system
from downloading information that is
already on the Net.
Synchronizing Messages and/or Fonts will
replace any messages or fonts that are on
the Net with those from the BoxWriter; any
additional messages or fonts will remain
on the Net. 

Name: The head’s user-defined
name.

Panel: The panel which the head
will print on.

Enc. Res: Encoder Resolution
indicates the resolution of the
external encoder. Valid values for
Encoder resolution are: 246, 300
or 600 dpi.

Print Res: Print Resolution repre-
sents the desired dots per inch
(dpi) print resolution. Print resolu-
tion depends on Encoder resolu-
tion. Valid values are:
• 246, 123, 82 or 61 for Encoder

resolution of 246 dpi
• 300, 150, 100 or 76 for

Encoder resolution of 300 dpi
• 600, 300, 200 or 150 for

Encoder resolution of 600 dpi

Head Type: Select a head type from the drop-down menu list.

Angle: Select the angle of the head with respect to the conveyor. Each head type has a set
of mounting angles that are selectable.

Print Height: The print height is the maximum print coverage of a single print head at a
selected angle.

Master: Each line must have a master head. The master print head receives/distributes the
signals for the photocell and encoder to the remaining heads. Only one controller may be
selected as the master print head.

Address: This is the IP address for the Marksman© Net Controller. The network administra-
tor should determine this address.
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Photo Delay: Photo Delay is the horizontal distance (in inches) measured from the photo-
cell to the print head. 

PC Repeater: The system will continue to perform print cycles at a distance determined by
the Auto Print Inches as long as the photocell is tripped.

Height on box: Height on box is the vertical distance in inches measured from the lower
part of the product or conveyor to the print head nozzle zero.

Enc. Speed: Encoder Speed is the desired internal encoder speed measured in feet per
minute. The default is 60 feet/min.

More Button: Used to configure the serial
port that is located on the Net.
The serial port on the Net can be used
for:
• None: Selected when the serial port

is not used.
• Variable data: Data that is sent

directly to the Net to be printed.
Select the Use once box to ensure
that the data is only printed once,
then discarded.

• Dynamic memory: Function is not
supported.

• Scanner to select label: Used to
select a message from a serial string.
Select the Use once box to print the
label once, then stop.

• System information: Can be used as
a diagnostic tool if instructed by
Technical Support.

Select the controller type:
• Net
• Next

Save Dynamic Data: This will allow
dynamic data to be stored on the control-
ler in case of a power failure. This option
should not be used if the data changes
with each print.
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Photocell source: Select "Head" if a Photocell is attached directly to the print head that the
controller is using. Select "Shared cable" if the photocell is coming from another controller
connected to the back using the encoder extension cordset.

Encoder source: The source of the encoder signal may be External (externally plugged in)
or Internal (internally generated).

Direction: The direction of travel of the product may be right-to-left (RtoL) or left-to-right
(LtoR), as viewed from behind the print head.

Standby: This option can only be used when the NP 192 type head is chosen. If the head
has not printed within the selected number of hours, the system will go into standby mode.
Standby mode will lower the head and reservoir temperatures and put the system into idle.
To bring the system out of standby, simply start the task.

Sync. Now: Allows the user to force the
BoxWriter to download the current mes-
sages and/or fonts to the Net or all Nets. 
Checking the "Delete all Data" box will
remove all information currently on the Net
Controller.
Synchronizing Messages and/or Fonts will
replace any messages or fonts that are on
the Net with those from the BoxWriter; any
additional messages or fonts will remain on
the Net. 
Checking the "All Heads" box will perform
the selected task(s) on all heads on the line.
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System

Barcode parameters

Refer to Section 7: BoxWriter Editor, Define, "Barcode Parameters".

Date/Time Codes

Refer to Section 7: BoxWriter Editor, Define, "Date/time codes".

Shift codes

Refer to Section 7: BoxWriter Editor, Define, "Shift codes".

Dynamic table

Refer to Section 7: BoxWriter Editor, Define, "Dynamic Table".

General settings

Allows for the parameter setting of the
COM ports available on the PC.
Please refer to Section 6: BoxWriter
Net, "Configuration" for additional
information. 

Strobe
Configure how the strobe reacts
based on the error or lack of error on
the Next controller.
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Security

Configure Users 

The security feature of the Marksman© Net
allows the system administrator to configure
users and access rights. Select Security,
then Users from the menu.

Add: Select the Add button to create a user
account.

Remove: Select the Remove button to
delete a user account.

Properties: Select the Properties button to
modify or view the user account informa-
tion.

Firstname: Enter the user’s
first name in this edit box.

Lastname: Enter the user’s
last name in this edit box.

Username: Enter a unique
user account name in this edit
box.

Password: Enter a unique
alphanumeric user password
in this edit box.

ReEnter Password: Enter the same password again for confirmation.

Security Group: Select a security group that provides the access level desired for the user.
The user’s security group options may be modified or the user may be assigned a different
group at a later date.

Click OK to save entries and exit the User Info dialog.
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Group Options 

Security groups allow the
administrator to assign similar
users with a specific set of
access rights. Select Security,
then Group Options from the
menu.
Ten configurable security
groups are available. A user
must be assigned to one group.
Group names may be modified
to better describe the access
level. Select a Group, then
select or unselect Options.
Click on OK to accept changes
and close screen.

The default access rights for each security group is shown in the following table: 

Security Group / 
Option Access Table

Configure Print Head Settings X X X X X
Start Print Task X X X
Stop Print Task X X X X X
Print Test Pattern X
Run Editor X
Configure Production Lines X X X X
Configure Users X
Configure Group Options X
System Communication Settings X
View Printer Report X
View Scanner Report X
Configure Date/Time Codes X
Define Global Bar Code Parameters X
Define the Shift Codes X
Quit the Application X
Database Start X
Modify User Element Data X
Change Count X
Enable/Disable Preview Mode X
Refresh Preview X
Configure Task Start Database X
Configure Dynamic Data Table X
Configure General Windows Settings X
Configure the Output Table X
Translate the Software X
Configure Strobe X
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Login

Each user must log in to the Marksman© Net application. The user may log in using the
system menu or by selecting the open padlock icon from the tool bar. The shortcut key
combination Ctrl+L may also be used.
User Name: Enter the user
name assigned by the sys-
tem administrator. The user-
name is not case sensitive.
Password: Enter the pass-
word assigned by the system
administrator. The password
is not case sensitive.
Press the OK button to log in.

Logout

Each user should log out of the Marksman© Net application to enforce the security restric-
tions. The user may log out using the system menu option Security > Logout. The user
may also select the closed padlock icon from the toolbar. The system will continue operat-
ing in its current state. All menu options are disabled after the user logs out with the excep-
tion of the Login, About, View Diagnostic Dialog and View Preview items.

Update Firmware

NOTE: It is extremely important that power is NOT removed from the Net or computer until
the firmware update process is complete. A screen will appear when it is safe to re-boot.
The process will take about two minutes to complete.

There may come a
time when the Firm-
ware (the code resid-
ing in the Marksman
Net) will need to be
updated. This can be
accomplished
through the Update
Firmware function.
Select Help, About
from the menu, then
select the file location
from the Firmware
tab. When the firm-
ware has been
updated, each Net
will have to be pow-
ered down and back
up again.

To upgrade the firmware on the Net, use the Browse button to select the version of firm-
ware to upgrade to. Select the Head or Net to be upgraded, then select Upgrade.
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Command line
fields that are
entered during
the installation
of the soft-
ware.

Translate

Access Help, Translate to select
the desired language to be con-
verted to. When the files have
been translated, the application
will be re-started in the desired
language.
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Operation

Operate Start Task 

The Start Task function is used to ready
the system to print a label or image that is
created with the BoxWriter© Editor.

Select Operate, then Start from the sys-
tem menu. Select the desired task from
the list and press the OK button. 

The Start Task icon may be selected from
the tool bar, or the shortcut key combina-
tion Ctrl+S may also be used to start a
task.

Reset Count to zero: This allows the count
value to accumulate if needed or to be
reset on every task.

Operate Stop Task 

Stopping a task halts all printing related to the selected production line. The product count
is reset to zero.

Select the desired production line from the folder tabs; then choose the menu options
Operate, then Stop to halt printing. 

The Stop Task icon may be selected from the tool bar to stop the task on the selected pro-
duction line; or the shortcut key combination Ctrl+End may be used to stop a task from
printing.

Operate Idle Task

The Idle Task option causes the printing to pause on the selected production line. The
product counts are halted until the current task is resumed. 

Select the menu options Operate, then Idle to pause printing. 

The Idle Task icon may be selected from the tool bar to invoke the idle function; or the
shortcut key combination Ctrl+I may be used to idle a running task.
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Operate Resume Task

The Resume Task option causes the printing to resume on the selected production line.
The product counts are restored from the previously idled task. 

Select the menu options Operate, then Resume to restore printing.

The Resume Task icon may be selected from the tool bar to initiate the resume function; or
the shortcut key combination Ctrl+R may be used to resume a task.

 

Operate Edit
The Edit menu option launches the Marksman© BoxWriter© Editor application. The user
must have the required access rights to use this feature. 
The Edit icon may be selected from the tool bar or the shortcut key Ctrl+E may be used to
launch the editor.

(See "Section 7: BoxWriter© Editor" for additional documentation.)
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Print Test Pattern

This function is not available in the Net.

Operate Change User Element

If a message was created with a
Dynamic Text field, then the data can be
entered into the message here. The
information can be changed as often as
necessary. 

Operate Change Counts

Set Counts: The count values being
printed can be changed by entering the
value and pressing OK.

Operate Exit

The user may exit the Marksman© Net application if the proper security level is assigned.
Under normal circumstances there should be no reason to exit the application.
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View

View Print Report

The Print Report contains historical information regarding the printing operation. The print
report is a table named reports within a Microsoft® Access® Database named Marksman-
Net. Click on View, then select Printer Report from the menu.

Time: Time is the date and time that the action occurred.

Action: Action indicates the event such as Start or Stop Task.

User: User is the name of the user who was logged in at the time the action occurred.

Line: Line is the print line that the information is for.

Task name: Task name is the name of the task for which the action applies.

Counts: Counts is the product count of the task for which the action applies.

Export: Export allows the information to be saved in a comma delimiter format so it can be
used in other software applications.

A sample Print Report is shown below:

Select Clear to remove all items from the report.
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View Scan Report

The Scan Report contains information relating to the current task and scan results of a
printed barcode. The scan results are received through the RS232 port from a barcode
scanner properly configured and connected to the Marksman© Net controller. 

NOTE: A Marksman© Hub is required to connect a scanner to the Marksman© Net Con-
troller.

Select View, then Scan Report from the menu.

Date: Date is the date the scan event occurred.

Line: Line is the production line that the scan event occurred on.

Task name: Task name is the task name operating while the scan event occurred.

Barcode: Barcode is the barcode data scanned and received. The contents of this field
may contain the words NO READ if the barcode could not be decoded.

Total: Total indicates the total number of decode attempts, including successful and failed
decodes.

Good: Good indicates the number of successful decodes of the scanned barcode.

Export: Export allows the information to be saved in a comma delimiter format so it can be
used in other software applications.

A sample Scan Report is shown below:

Select Clear to remove all items from the report.
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View Diagnostic Dialog

The Diagnostic Dialog is designed to aid in debugging and verifying the data stream from
the serial ports on the Marksman© Hub. Select View, then Diagnostic Dialog from the
menu.

The most common use is to verify that a data string has been received from a device con-
nected to the Marksman© Hub and that is in the proper format.

Select Clear to remove all items from the dialog.

Preview

By selecting Preview, the task that is selected will be displayed on the main screen. It may
be necessary at times to disable this feature to improve the performance of the system.

Zoom used with the Preview screen. Zoom in or out based on print heads being used.
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Section 7: BoxWriter© Editor

Define

Boxes

To define boxes, select Define,
then Boxes.

To add a new box, click Add.
Enter the length, width, height
and name. The description field
is optional. The length, width
and height fields must be
between 1 and 40 inches. Click
OK.

To edit an existing box, select it
and click Edit, or double-click
the item. 

To delete an existing box,
select it and click Delete. Multi-
ple boxes can be selected by
using the shift and/or control
keys. Boxes that are currently
in use in a task cannot be
deleted. The task’s box prop-
erty must be changed before
the box can be deleted here.

Pre-printed information can be
added to the box to give the
operator a true representation
of how the box will look as it is
being printed on.
Add: Allows the operator to
assign a .bmp or .jpg file to a
panel on the box.
Edit: Allows the operator to
change which .bmp or .jpg file
is assigned to a panel of the
box.
Delete: Will remove the file
from the panel.
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Box usage

To define box usage, select
Define, then Box usage.

If it is desirable to restrict a
box from a given line, it can
be done here. By default, all
new boxes are available on
all lines. To restrict a box,
select the line, then select
the box. It can then be
moved to the Restricted list
by clicking the "<" key.
Clicking the "<<" moves all
boxes for a given line to the
restricted list, regardless of
selection. Conversely, the
">" and ">>" keys move
boxes to the Available list.

Editor defaults

To define editor defaults, select Define, then
Editor defaults. 

This dialog controls the Editor's display units. To
change the defaults, click the desired units, then
click OK.
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Element defaults

To define element defaults, select
Define, then Element defaults. To
change the defaults, select an ele-
ment type and click Properties, or
double-click the item.

The elements listed here define
how new elements are created.
(For a description of the individual
elements, refer to the section on
“Elements” on page 63 and follow-
ing.

To change the font, click the
Change button. (For a description
of the font dialog, refer to “Fonts” on
page 50.)

Bitmap settings

To define bitmap settings,
select Define, then Bitmap
settings.

The Bitmap editor field defines
the program used to edit bit-
maps. By default, it is Micro-
soft® Paint. To change it, click
the Browse button and select
the program to be used. Click
OK to save changes and exit
screen.

The Bitmap path field defines where bitmaps used by the Marksman® Net are stored. Note
that all bitmaps must reside in this directory. The software does not support sub-directories
in the Bitmap path.
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Shift codes

Shift codes are used by Date / Time elements that have their Format field set to "SHIFT".

To define shift codes, select
Define, then Shift codes.
(From the Net, select Config-
ure, System, then Shift
codes.)

Line: Line determines the pro-
duction line for the shift code
definitions.

Select the appropriate produc-
tion line. Enter the shift start
times and any user-defined
codes. The shift start times
must be entered in 24-hour for-
mat. The length of a shift code must be from 1 to 15 alphanumeric characters. The times
must be in order from least to greatest (i.e., code 1 cannot be later than code 2 or 3). Select
Apply to apply the changes and leave the window open; select OK to save the changes
and exit the window.

The sample dialog shows shift 1 starting at 7:00 AM, shift 2 starting at 3:00 PM and shift 3
starting at 11:00 PM.

Date/time codes

This dialog defines parameters used by Date / time elements.

To define date/time codes, select Define,
then Date/time codes. (From the Net,
select Configure, System, then Date/Time
codes.)

Line: Line indicates the production line
selected. 

Week day: Week day is the first day of the
week. The default is Sunday.

Week 1: Week 1 indicates the number of
days in the first week of the year.

Week 53: Week 53 is the number of print
weeks in a complete year. A partial week
counts as a week.
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Rollover hours: The Rollover hours value indicates the number of hours after midnight at
which the system will start a new date. A rollover value of 2 will advance the printed date at
2:00 AM; a rollover value of 0 will advance the date at midnight. 

Click on the tabs to access the date/time code tables. Select an entry in the table by click-
ing on the desired row. Click on Edit to modify the data for the selected table entry. 

Click OK to exit and save changes or Cancel to exit without saving changes.

Days: Days represents the string values that are used in date codes for standard days of
the week.

Months: Months represents the string values that are used in date codes for the standard
months of the year.

Special Days: The Special days table represents the string values that are used in custom
date codes for days of the week.

Special Months: The Special months table represents the string values that are used in
custom date codes for months of the year.

Hours: The Hours table stores the twenty-four codes for the hours of the day. The codes
may be customized for special coding.

AM/PM: This indicates the AM and PM designators. These may be modified for custom
codes.

Select Apply to apply the changes and leave the window open; select OK to save the
changes and exit the window.

The following table designates how the Date / time codes are used: 

All string values here must be between 1 and 15 characters.

Note that Special days and Special months are only used when the "Use 'special' code"
property is set on the Date / time element. See “Date / time” on page 67 for more informa-
tion.

Tab Date/Time Element "Format" Field

Days DAYWKA
Months MONTHA

Special Days DAYWKA
Special Months MONTHA

Hours HOURA
AM/PM AMPM
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Fonts

To define fonts, select
Define, then Fonts. 

Font properties can be
viewed here by selecting
a given font in the Font
name list.

The font directory can be
changed here as well. 
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Barcode Parameters 

The barcode parameter dialog allows the system administrator to modify the properties of
the barcode symbologies. Only a person having advanced knowledge of barcode and ink-
jet printing systems should change these parameters. An unusable barcode may be printed
using improper settings. 

To define barcode parame-
ters, select Define, then Bar-
code parameters. (From the
Net, select Configure, Sys-
tem, then Barcode parame-
ters.)

Select the line, then select
the head type. Heads with 32
channels have their own set
of barcode parameters, as do
256/128 channel heads.

Line: Line determines the
production line to which the
settings will apply.

Head type: Head type deter-
mines the channel configura-
tion of the print head.

The barcodes available for
editing are shown in the list at
right.

Default barcode parameters can be loaded for certain configurations. They are:

32 Channel Heads:
• 352 Print Head at 150 dpi (V300 Ink)

256 Channel Heads:
• 768 Print Head at 200 or 300 dpi (ScanTrue® II Ink) (Also used for 384 Heads.)
• Code 128 at 300 dpi

To load these pre-defined defaults,
select the applicable set under "Default
settings" and click Load. The user will
be prompted with a confirmation mes-
sage like the one at right.

Click Yes to overwrite the old parame-
ters, or No to cancel.
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To view or edit a set of bar-
code parameters, select it
then click Edit, or double-
click the item. Bar height,
quiet zone, bearer bars,
check sum, narrow bar spac-
ing and bleed factors are
specified here.

Unless otherwise noted, all
units are in pixels.

Type: Type determines the
specific barcode symbology.
The symbology currently
available is Interleaved 2 of 5,
Code 39 and Code 128.

Name: Name indicates the
specific magnification of the
barcode symbology.

Height: Height indicates the vertical height of the barcode in pixels.

Quite zone: Quiet zone indicates the width of the quiet zone in pixels on either end of a bar-
code. The quiet zone is a minimum of 10 times the narrow bar width.

Checksum: Checksum determines if a checksum is calculated and appended to the bar-
code and displayed in the human readable data. The use of a checksum is recommended
for most barcode applications.

Bearer bars:
• Horizontal - This indicates the height (in pixels) of the upper and lower horizontal bearer

bars.
• Vertical - This indicates the width (in pixels) of the left-most and right-most vertical

bearer bars.

Bar spacing:
• Narrow unit (in thousandths of an inch) - This is the X-dimension of the narrow bar of a

barcode.
• Bleed factors 1 through 4 - These factors should not be changed; consult the Distribu-

tor.

Select the OK button to exit and save changes. Select the Cancel button to exit without
saving.
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Dynamic Table

Dynamic Table is used in conjunc-
tion with Dynamic Text and
Dynamic Barcode. The Dynamic
Table is used to set the default data
and configure the field to prompt
the operator to enter in data before
starting the task. The data to be
printed may also come from a data-
base if "Use database" is selected.

When the dynamic fields are
inserted into a message, they allow
the operator a means of inputting
information to be printed without
giving them access to the Editor.

To select an item for editing, click
on the line number, not the ID check
box. 
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File

New

To create a new task,
choose File, then New.

You will be presented with
the dialog at right. Pick the
production line the task is to
be created for, give it a name
(and description, if desired)
and select the box it will be
printed on.

The Task name field must
contain only letters and num-
bers. No spaces or special
characters are allowed. The
maximum number of charac-
ters is 32.

Click OK.
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Creating a Task

The next step is to insert elements into the label to be printed. The box is shown with high-
lighted areas showing where heads have been placed on the box. The printing areas can-
not be changed from the editor because the information about the heads and their
relationship to the box comes from the system configuration, which is limited by physical
devices installed.   Different panels can be selected to add elements to the task. Once a
head has been chosen, select an element to be placed on the box. The process is
repeated until all the desired information needed on all sides of the box are completed. The
next step would be to save the task. (Refer to appropriate sections in this manual relating
to Elements and Saving Files.) 

NOTE: If two elements overlap each other they both will show up in red. This is to let the
operator know that a problem may occur. The operator will also be told before saving the
task. 
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Open

To open an existing task,
choose File, then Open.

Select the task you want to
open, and click OK; or dou-
ble-click the task you want to
open.

Checking the "open read
only" box will open the task in
read-only mode (i.e., you will
not be able to modify the
task). 

Checking the "show preview"
box will show a preview of the
selected task. For large tasks,
it may take several seconds
to generate the preview.



 Section 7: BoxWriter© EditorBoxWriter Net Software

2464-308 User Manual Rev F, Version 3.54 Page 57

Copy

To copy tasks from one line to another, choose File, then Copy.

Select the line to copy from, then select the tasks to be copied. Checking the "all" box will
automatically select all existing tasks for the given line.

When the desired tasks are selected, click Copy.

If successful, a confirmation message similar to
the one at right will appear.

The user may change both the "To" and "From"
lines and perform the copy function multiple
times. 

Click OK to save the changes.

This function works best when both the "To" and "From" lines have identical head configu-
rations. However, if they do not, the user may elect to configure the head mapping. To do
this, select the head to be to mapped and click Edit, or double-click the item.
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At the dialog, select the head to
be mapped to in the "To" field and
click OK. 

Clicking Properties will bring up
the Head properties dialog.

Note that head properties are
read-only in the Editor.
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Import

NOTE: It is recommended that all printing tasks be stopped until the Import function has
been successfully completed and that the current database be exported for backup pur-
poses.

To import all tasks that were pre-
viously exported, choose File,
then Import.

In the "filename" field, input the
name of the file (full path) the
exported tasks were saved to; or
browse for the file by clicking the
Browse button. 

If there is data on the controller that the user does not want to lose, click Yes on the follow-
ing screen. 

The screen at right will appear at the
completion of the Import function.
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Export

NOTE: It is recommended that all printing tasks be stopped until the Export function has
been successfully completed.

To export all existing tasks,
choose File, then Export.

Input the name of the file to
export to, or browse for an
existing file by clicking the
Browse button. Click the
Export button. If the file
already exists, the user will
be prompted to overwrite the
file or cancel the request.

If successful, a confirmation message will appear.

Delete

To delete existing tasks, choose
File, then Delete.

Select the task to be deleted, or
select multiple tasks by using the
control and/or shift keys. When
the selection has been made,
click Delete. 

The delete function may be used
several times without closing the
window.   Tasks on other lines
may also be deleted.

Click OK to save the changes.

Checking the "Show preview"
box will show a preview of the
selected task. For large tasks, it
may take several seconds to
generate the preview.
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Save as

To save an open task under a
different name, choose File,
then Save as. 

The File field must contain only
letters and numbers; no spaces
or special characters are
allowed. The maximum number
of characters is 32.

If the name entered
matches a task already in
the database, the user will
be prompted with a confir-
mation dialog, like the one
at right.
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Properties

To change an open task's properties, choose File, then Properties. The task's description,
download string, box and/or expiration data may be changed using this dialog.

Expiration Data: The value and units entered here will be used in calculating an Expiration
or Rollover Expiration type Date/Time Element.

The following table lists special ASCII characters that can be entered in the "Download
String" field. (For example, to send 0012345 terminated by a carriage return, enter
"0012345<CR>" in the Download String.) 

Exit

To exit the Editor, choose File, then Exit.

Character Description Character Description
<NULL> Null <SLE>
<SOH> Start of heading <DC1> Device control 1
<STX> Start of text <DC2> Device control 2
<ETX> End of text <DC3> Device control 3
<EOT> End of transmission <DC4> Device control 4
<ENQ> Enquiry <NAK> Negative acknowledge
<ACK> Acknowledge <SYN> Synchronous idle
<BEL> Bell <ETB> End of transmission block
<BS> Backspace <CAN> Cancel
<HT> Horizontal tab <EM> End of medium
<LF> NL Line feed, New line <SIB> Substitute
<VT> Vertical tab <ESC> Escape
<FF> NP Form feed, New page <FS> File separator
<CR> Carriage return <GS> Group separator
<SO> Shift out <RS> Record separator
<SI> Shift in <US> Unit separator
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Elements

Element Bar

Using the Element bar, the user can add new elements to a task. Element types, from left
to right, are as follows:
• Text
• Bitmap
• Count
• Date / time
• Barcode
• Dynamic text
• Dynamic barcode

New elements can be created by clicking one of the buttons on the Element bar, by right-
clicking on the printable area of the box, or by using the Elements > Add menu.
When creating a new element, its x, y position (top left corner) is set to the current location
of the crosshairs.
To edit an existing element’s properties, select the element by clicking it, then choose Ele-
ments > Edit from the menu (or press Enter). You may also double-click an element to edit
its properties. Only one element can be selected at a time to edit.

Text

The Text element properties dia-
log is shown at right. The maxi-
mum number of characters
allowed in the Text field is 256.
The supported character set
depends on the selected font.
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The "Bold" value is used to lengthen the image by means of duplicating each imaged col-
umn the number of times specified.

The "Width" value is used to lengthen the image by means of inserting the specified num-
ber of white columns between each imaged column.

The "Gap" value specifies the number of white columns added between each character.

The following are examples of various bold, width and gap values:

Figure 1: Bold: 0, Width: 1, Gap: 0

 

Figure 2: Bold: 3, Width: 1, Gap: 0

 
Figure 3: Bold: 0, Width: 5, Gap: 0

Figure 4: Bold: 0, Width: 1, Gap: 50

See “Alignment bar” on page 79 for a description of the Flip horizontal, Flip vertical, and
Inverse attributes.

Field Minimum Value Maximum Value
Bold 0 9

Width 1 9
Gap 0 255
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Bitmap

The Bitmap Properties dialog is shown at
right.

The user may browse for a different bitmap by clicking the Browse button.

The user may edit the currently selected bitmap by clicking the Edit button. This will invoke
the bitmap editor, which by default, is Microsoft® Paint.

Note that all bitmaps must reside in the same directory. 

To change the default bitmap editor, or the bitmap directory, see “Bitmap settings” on
page 47.

See “Text” on page 63 for a description of the Bold and Width attributes.

See “Alignment bar” on page 79 for a description of the Flip horizontal, Flip vertical, and
Inverse attributes.

Field Minimum Value Maximum Value

Bold 0 9
Width 1 9
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Count

The Count Properties dialog is
shown at right. 

The Change field is used to increment the current count (i.e., a Change of 2 would cause
the element to print 1, 3, 5, etc.).

The Repeat field determines how many times the current count is printed (i.e., a Repeat of
2 would cause the element to print 1, 1, 2, 2, 3, 3, etc.).

The Start field determines the initial value of the counter when the task is started.

The Limit field determines the maximum value to be printed. When the current count
exceeds the Limit, it will roll over back to the Start value.

Field Minimum Value Maximum Value

Bold 0 9
Width 1 9
Gap 0 255

Change 1 999
Repeat 0 134217727
Start 0 134217727
Limit 0 134217727

Length 0 9
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The Length field determines the minimum number of characters imaged (i.e., a Length of 5
would cause the element to print 00001, 00002, 00003, etc.).

The Fill field is used to pad the element with a specified character if it is right aligned. This
field will accept any alpha-numeric character.

See “Text” on page 63 For a description of the Bold, Width, and Gap attributes.

See “Alignment bar” on page 79 for a description of the Flip horizontal, Flip vertical, and
Inverse attributes.

Date / time 

The Date/time Properties dia-
log is shown at right.

Field Minimum Value Maximum Value

Bold 0 9
Width 1 9
Gap 0 255

Length 0 9
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The Format field determines the type of date / time data to be printed. See “Date/time
codes” on page 48 for information on how to change the defaults. 

NOTE: All samples in the above table are based on the date and time of January 8, 2004,
6:02:13 PM.

Possible values for the Type field are: 
• Normal - current date
• Expiration - current date plus expiration value (See “Properties” on page 62 to config-

ure expiration parameters.)
• Rollover - time at which the system starts a new date (See “Date/time codes” on

page 48.)
• Rollover expiration - the values for Rollover Hours and Expiration Data will be com-

bined to get the result for this field type

Format Type Sample
YYYYMMDD 2004:01:08
DDMMYYYY 08:01:2004
MMDDYYYY 01:08:2004

YYYY 2004
MM (date) 01

DD 08
YYMMDD 04:01:08
DDMMYY 08:01:04
MMDDYY 01:08:04

YY 04
DAYWK 5

WK 1
JULIAN 8

MONTHA January
DAYWKA Thursday

HHMMSS24 18:02:13
HHMMSS12 06:02:13

HHMMSS12M 06:02:13PM
HHMM24 18:02
HHMM12 06:02

HHMM12M 06:02PM
HH 18

MM (time) 02
SS 13

AMPM PM
HOURA Nineteen
SHIFT 2nd
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The Length field determines the minimum number of characters imaged (i.e., a Length of 5
would cause the element to print 00001, 00002, 00003, etc.).

The Fill field is used to pad the element with a specified character if it is right aligned. This
field will accept any alpha-numeric character.

The Delimiter field specifies the delimiter to be inserted between the components of the
Date / time element (i.e., in the example of 6:02:13, the ":" character is the delimiter).

The Hour A Count field is only applicable when the "HOURA" format is selected.

See “Text” on page 63 for a description of the Bold, Width, and Gap attributes.

See “Alignment bar” on page 79 for a description of the Flip horizontal, Flip vertical, and
Inverse attributes.

Barcode

The Barcode Prop-
erties dialog is
shown at right.

The Text field contains the data to be encoded in the barcode. Up to 32 numeric characters
can be encoded.

Field Minimum Value Maximum Value

Bold 0 9
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The Alignment attribute determines how the barcode's caption is formatted. The following
are examples:

Figure 5: Right aligned
 

Figure 6: Left aligned
 

Figure 7: Center

See “Text” on page 63 for a description of the Bold attribute.

See “Alignment bar” on page 79 for a description of the Flip horizontal, Flip vertical, and
Inverse attributes.
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Dynamic Text

The Dynamic text properties dia-
log is shown at right.

Dynamic ID is used in conjunc-
tion with the Dynamic Table; the
ID number links the two fields
together.

Data can also come from a serial
device connected directly to the
COM port of the Net. The First
char is where the data to be
printed starts at, and the Num-
ber of chars is how many char-
acters are to be printed from the
string.

Length: Sets the length of the
string of characters to be
printed. If the length is longer
than the Number of Characters,
then Fill Characters will be
inserted.

First char: Select the first char-
acter of the serial string to be
printed.

Number of chars: Select the number of characters in the string that is to be printed.

Example:
Serial string "10/10/2005 001.25lbs 23:05". The weight 001.25 lbs, needs to be printed
from the string. The start character is 12, and the number of characters = 9.
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Dynamic Barcodes

The Dynamic barcode properties dialog is shown at right

Dynamic ID is used
in conjunction with
the Dynamic Table;
the ID number links
the two fields
together.

If the barcode data is
to come from a serial
device connected
directly to the COM
port of the Net, the
First char is where
the data to be
printed starts at, and
the Number of
chars is how many
characters are to be
printed from the
string.
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Toolbars

Toolbar

Toolbar icons are listed in the table below in order from left to right:

New

Creates a new task. See “New” on page 54.

Open

Opens an existing task. See “Open” on page 56.

Save

Saves the task currently being edited.

Save all

Saves all open tasks.

Cut

Cuts the selected elements and places them on the clipboard.

Copy

Copies the selected elements to the clipboard.

Paste

Pastes the contents of the clipboard into the current task. 
New elements created by this operation will have their position set relative to the current
cross hair position.

Button Menu Command Keyboard Shortcut
New File > New Ctrl + N
Open File > Open Ctrl + O
Save File > Save Ctrl + S

Save all File > Save all
Cut Edit > Cut Ctrl + X

Copy Edit > Copy Ctrl + C
Paste Edit > Paste Ctrl + V
Undo Edit > Undo Ctrl + Z
Redo Edit > Redo Ctrl + Y

Zoom in View > Zoom > In +
Zoom out View > Zoom > Out -

Zoom normal View > Zoom > Normal
Zoom custom View > Zoom > Custom

About Help > About F1
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Undo

Undoes the most recent operation.

Redo

Redoes the most recent Undo operation.

Zoom in

Zooms the current view in by increments of 25%.

Zoom out

Zooms the current view out by increments of 25%.

Zoom normal

Sets the current view's zoom to 100%.

Zoom custom

This command allows the user to
set an arbitrary zoom factor for
the current view. Valid zoom fac-
tors are in the range of 10% to
200%.

About

This command displays the About dialog. This dialog lists all the major components of the
editor and their version numbers.

Font bar

The Font bar allows the user to
change the font properties of any
selected elements that have a font
(i.e., Text, Count and Date / time elements).

Font bar fields, from left to right, are as follows:
• Name
• Size
• Width

Name

The name of the currently selected font - See “Fonts” on page 50 for more information.

Size

The font's size - For bitmap fonts, each font listed in the Name list only has one size.

Width

Width factor of the font - Valid ranges are between 1 and 9.
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Rotation bar

The Rotation bar allows the user to change the box's orienta-
tion, relative to the print heads.

The buttons rotate the box in the following order (starting from
the left-most button):

• Counter-clockwise
• Clockwise
• Down
• Up
• Left
• Right

The following are illustrations of some possible rotations. First, suppose our box has a
length, width and height of 12 inches, 6 inches and 3 inches, respectively. By default, it has
the following orientation in a new task: 3 inches tall, by 6 inches long of printable area.
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Spinning the box clockwise (or counter clockwise) will result in a printable area that is now
6 inches tall, by 3 inches long.
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Spinning the box up (or down) will result in a printable area that is now 12 inches tall, by 6
inches long.
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Spinning the box left (or right) will result in a printable area that is now 3 inches tall, by 12
inches long.

Sometimes changing the box's orientation will result in some elements being forced outside
the printable area. When this happens, the Editor will warn the user with the following mes-
sage:

If it is acceptable to move the affected elements, click Yes and they will automatically be
repositioned. Otherwise, click No and the box will be returned to its original orientation.
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Alignment bar

The Alignment bar allows
the user to apply various
transformations to the cur-
rently selected elements.

Alignment bar icons are listed in the table below in order from left to right:

Figure 1: Left aligned

 

Button Keyboard Shortcut Minimum number of ele-
ments that must be 

selected
Left 2

Center 2
Right 2
Top 2

Middle 2
Bottom 2

Center (on box) 1
Distribute evenly vertically 3

Distribute evenly horizontally 3
Bold Ctrl + B 1
Italic (currently not implemented)

Flip horizontally 1
Flip vertically 1

Inverse 1
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Figure 2: Center aligned

 
Figure 3: Right aligned

 

 

Figure 4: Top aligned

 

Figure 5: Middle aligned

 
Figure 6: Bottom aligned

 

Figure 7: Center (on box)
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Figure 8: Distribute evenly vertically

 

Figure 9: Distribute evenly horizontally

 
Figure 10: Text element with no bold factor

 

Figure 11: Bold factor of 3

 

Figure 12: Flip horizontally

 

Figure 13: Flip vertically

 

Figure 14: Inverse
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Perspective

To change the perspective of the box view,
select View, then Change perspective.

 

The x and y axis perspectives must be
between -90 and 90 degrees.

 
Figure 1: Perspective as viewed with [x, y] set to 20, 10.
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Figure 2: Perspective as viewed with [x, y] set to -20, 10.
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Section 8: Maintenance

APS - Automatic Priming System

NOTE: The system will not prime either manually or automatically if there is a low ink indi-
cation. Low ink indication is caused by either low ink in the reservoir or full ink in the waste
collection bottle.

The APS is an invaluable tool for routine cleaning of loose debris from the print engine
face. The images below demonstrate print before and after the APS.

NOTE: The duration of the APS cycle is approximately 5 - 10 seconds.

BEFORE APS

AFTER APS
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Shutdown Procedures

Daily - 8 Hours
• Dust touch screen and keyboard with lint-free cloth.
• Make sure the cabinet fan(s) are working.
• inspect print head assemblies for leaks and wipe with lint-free cloth as necessary.

NOTE: Do not wipe the print head faceplate!

• Inspect for broken or worn electrical connections.
• If missing channels occur in printed message, purge print head.
Inspect guide box rails and print head bracket for wear.

Overnight and 1 to 3 Days:
Idle the system through the software to avoid any misprinting. It’s OK to leave the system
powered up during this time.
Use the priming and purging procedure after this period of inactivity to remove any dust or
debris that might have collected on the print head faceplate.

Periods of More Than 3 Days:
If the heads are not to be used for longer than three days, it is recommend that the control-
ler be turned off. 
• Exit the software.
• Power the system down.
• Close the reservoir vent cap.
• Replace the Ship Cap.
Upon power up, allow the head to heat up and perform a visual inspection on the heads
before using. Run an APS cycle to insure all the channels are clear.
• Remove the Ship Cap.
• Open the reservoir vent cap.
• Power up the system.
• Use one of the priming procedures to remove any air or debris that may have entered

the print head or faceplate.

3 Weeks - 120 hours
• Wipe print head cases and ink reservoir covers with lint-free cloth.
• Clean printer cabinet with cloth to remove dust.
• Have qualified person open printer cabinet and inspect for dust. If necessary, blow out

dust with low-pressure air that is moisture- and oil-free.
• Inspect the fan filter and replace if necessary. See below for procedure.
• Make sure the fan turns freely.
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3 Months - 500 hours
• Wipe print head cases and ink reservoir covers with lint-free cloth.

NOTE: Do not wipe the print head faceplate!

• Clean printer cabinet with cloth to remove dust.
• Have qualified person open printer cabinet and inspect for dust. If necessary, blow out

dust with low-pressure air that is moisture- and oil-free.
• Replace fan filter and inspect for bearing wear. Replace if necessary. To replace fan fil-

ter, simply remove the louver plates on the outside side panels of the Marksman©. The
filter is located under this plate. The fan filter can be cleaned with low-pressure air. For
thorough cleaning, clean with soap and water and allow to dry before re-installing.

With the printer off, make sure tie wraps securely hold all cables. Replace any missing tie
wraps or damaged cables.
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Section 9: Troubleshooting

The Marksman© Net ink jet system incorporates advanced designs, both in hardware and
in software. However, if the system ever fails to perform properly, some built-in indicators
will help in troubleshooting. This section will help minimize system downtime and explain
some of the diagnostic features built into the system.

If the flash memory ever gets corrupted in the Marksman Net, it will automatically load the
default settings. This includes the IP address of the Marksman Net. The default IP address
is 10.1.2.100. If it is suspected that the Net has loaded the default IP address, simply
power up the Marksman Net for one minute then remove power and re-apply power to the
Net. The Marksman Net will detect that the IP address was set to the default setting and
then set it back to the pre-fault value.

Troubleshooting Notes
Most controller problems will be the result of improperly connected cables. Check all con-
nections, including power interface, print heads, encoder, and photosensor. (See “Appen-
dix B: Theory of Operation” on page 103 for details.)

Problem: Cannot communicate to the Marksman© Net through the Ethernet. 
Action: 
• Power down, then power up the computer and the Marksman© Net.
• Check for proper Ethernet cabling.
• Verify that the IP addresses are valid for the computer and the Marksman© Net.

Problem: The system does not print.
Action:
• Check that there are no errors on the head.
• Check that the encoder is active.
• Check that the photocell is enabled, sensing a product.
• Check that the configuration is correct for the head being used.
• Check that a valid label is selected.

Problem: No Shaft Encoder.
Action:
• Make sure that the encoder wheel is contacting the conveyor.
• Make sure that the encoder is connected and plugged in to the proper port.
• Check the configuration for proper setup.
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Troubleshooting Tests

Print Test

This test will determine if the print heads are printing.
1. Place cloth in front of print head front plate.
2. Initiate print cycle by turning on conveyor and tripping photocell.
3. Check for ink on cloth.
Printed dots on cloth indicate that the system is printing. Check product sensor offset set-
tings, product length, or product margins if print is not seen on carton.
No ink on cloth indicates that the system is not printing. Review system status to determine
other possible causes of system not printing, including a test of the photosensor and
encoder to ensure operation.

Photosensor Sensitivity Test

This test will determine if the photosensor sensitivity is adjusted correctly for the applica-
tion.
1. Place object approximately ¼ inch in front of photosensor; photosensor should sense

object.
2. Place object near the center of the guide rails; photosensor should sense object.
3. Place object on far guide rail; photosensor should not sense object. 
4. Check that objects on the far side of conveyor do not trip the photosensor.
5. Check that color differences in product do not cause multiple photosensor trips at the

farthest sensing distance. 

NOTE: The test object should be a sample of the actual product. 

NOTE: If the red LED on the photosensor fails to illuminate when an object is placed in
front of (but not touching) it, this is an indication that the photosensor is disconnected, or
the power supply or photosensor has failed. 
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Network Test

Ping the Marksman Net: From a Command Prompt type: C:\ping "IP address of the Net
being tested" <enter>

Example if IP address of Net being tested is 10.1.2.100:
C:\ping 10.1.2.100 <CR>

Good connection:
Pinging 10.1.2.100 with 32 bytes of data:

Reply from 10.1.2.100: bytes=32 time =1ms TTL=60
Reply from 10.1.2.100: bytes=32 time <10ms TTL=60
Reply from 10.1.2.100: bytes=32 time <10ms TTL=60
Reply from 10.1.2.100: bytes=32 time <10ms TTL=60

Ping statistics from 10.1.2.100:
Packets: Sent = 4, Received = 4, Lost = 0 <0% loss>,

Approximate round trip times in milliseconds:
Minimum = 0ms, Maximum = 1ms, Average = 0ms

Bad connection:
Pinging 10.1.2.100 with 32 bytes of data:

Request timed out.
Request timed out.
Request timed out.
Request timed out.

Ping statistics from 10.1.2.100:
Packets: Sent = 4, Received = 0, Lost = 4 <100% loss>,

Approximate round trip times in milliseconds:
Minimum = 0ms, Maximum = 0ms, Average = 0ms
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Print Quality Troubleshooting
This section shows examples of various print problems and actions which should be taken
to improve the print.

Problem: Minor fractures in print channels.
Possible Cause: Debris on front plate, air in channel.
Action: Run APS. Add brushes and positive air flow to minimize debris build-up.

Problem: Missing channels and channel fractures in print channels.
Possible Cause: Excessive debris on front plate, air in channel.
Action: Wipe front plate and run APS. Add brushes and positive air flow to minimize debris
build-up.

Problem: Missing print channels.
Possible Cause: Air in channel.
Action: Run APS. If air cannot be removed, run a Prime Cycle per instructions in Section
4: Installation.
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Problem: Missing bottom print channels.
Possible Cause: Ink build-up on lower orifices.
Action: Wipe front plate and run APS.

Problem: Fuzzy print.
Possible Cause: Print head too far away from substrate.
Action: Move print head to within 1/8" from product.

Problem: Occasional checkerboard print pattern.
Possible Cause: Encoder slipping or bouncing on belt.
Action: Tighten encoder on belt; replace encoder o-rings, if required; or replace conveyor
belt with smooth seamless belt.
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Problem: Stretched out, light print, checkerboard pattern.
Possible Cause: Incorrect encoder, or incorrect line speed (set too low) if using internal
encoder.
Action: Check for correct encoder (use 5000 PPR Encoder).

Problem: Short image, dark print, checkerboard pattern.
Possible Cause: Incorrect encoder or wheel size, or incorrect line speed (set too high) if
using internal encoder.
Action: Check for correct encoder (use 5000 PPR Encoder).
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Appendix A: Specifications

Controller Specifications 

Processor: Digi NS9215, operating at 150 MHZ
Supply Input: 100-240VAC, 50-60Hz at 1.5A max
Ports: RS232

Strobe, 3-Color
10/100 Base-T Ethernet
Power, 24VDC at 3.0A
Print head, ProSeries
Encoder/PC Input
Encoder/PC Output

Enclosure: Extruded aluminum
Weight (Controller only): 2.3 lbs
Indicators: Power: Green

Activity: Green, flashing
Malfunction: Red, Low Ink, Low Temp, No HV, Out of Ink

7.75”
[196.9 mm]

5.50” [139.7 mm]

2.20” [55.9 mm]

2X #10-32 x .25 DEEP
(BOTH SIDES)

3.00” [76.2 mm]

1.89” [47.9 mm]

1.06” [27.0 mm]
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User Interface: Marksman© Net Application, or equivalent, is required
Environment: Ambient operating temperature: 40° to 104° F (5° to 40° C)

Operating humidity: 10-90%, non-condensing
Printheads: 1 ProSeries print head
Storage: 4 Meg Flash Memory for logos, fonts and messages
Alarms: 24V 3-Color optional beacon
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Print Head Specifications 
96, 192 and 352 Print Heads:

384 Print Head: 

768 Print Head: 

20.89” [530.6 mm]

12.02” [305.2 mm]3.00”
[76.2 mm]

2X #10-32 x .25 DEEP
(BOTH SIDES)

2.75” [69.9 mm]

1.02”
[25.8 mm]

14.47”
[367.5 mm]

5.00”
[127.0 mm]

3.02”
[76.6 mm]

5.50” [139.7 mm]

12.00” [304.8 mm]

13.14” [333.8 mm]3.00”
[76.2 mm]

2X #10-32 x .25 DEEP
(BOTH SIDES)

22.01” [559.1 mm]

12.00” [304.8 mm]

2.80” [71.1 mm]

1.07”
[27.2 mm]

14.47”
[367.5 mm]

6.32”
[160.5 mm]

5.50” [139.7 mm]

3.02”
[76.6 mm]
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AlphaCoder Head:

Electrical Connections: Standard 30" (.76m) length
Optional 25’ (7.5m) length extension cable

Print Orientation: Integrated - Horizontal or horizontal angle (for incline printing)
Ink System: Non-pressurized capillary feed technology

Priming: Automatic Priming System (not included with Alpha-
Coder Print Heads)
Float switch sensor: Low ink and full waste bottle detection
(waste detection not included with AlphaCoder Print Heads)

Ink Specifications: ScanTrue II® (192, 384, 768 and AlphaCoder Print Heads), 
Pigmented oil-based for porous surfaces
VersaPrint™ V300 (192 and 352 Print Heads), Glycol-oil
based for porous surfaces

Technical Data: 

Operating Conditions: Temperature: 50° - 104° F (10° - 40° C)
Relative Humidity: 20 - 80% (non-condensing)

Storage Conditions: Temperature: 32° - 109°F (0° - 43° C)
Relative Humidity: 20 - 80% (non-condensing)

192 Head 352 Head 384 Head 768 Head AlphaCoder 
Head

Image Area: .2" - 1"
(5 - 25mm)

.38" - 1.9"
(10 - 48mm)

.38" - 2"
(10 - 51mm)

.38" - 4"
(10 - 

102mm)

.75" - 1.9" 
(19 - 48mm)

Channels: 32 32 128 256 32
Orifices: 192 352 384 768 224
Horizontal 
Resolution:

150 or
300 dpi

150 or
300 dpi

150 or
300 dpi

150 or
300 dpi

150 or 
300 dpi

Lines of Print: 1 - 5 1 - 5 1 - 21 1 - 42 1 - 5

17.68 [448.9 mm]

8.67 [220.1 mm]

11.99 [304.5 mm]3.00 [76.2 mm]

2X #10-32 X .25 DEEP
(BOTH SIDES)

3.02 [76.6 mm]

1.03 [26.2 mm]

5.00 [127.0 mm]

2.75 [69.9 mm]

5.50 [139.7 mm]1.06 [27.0 mm]

2.41 [61.1 mm]

1.66 [42.2 mm]
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Labels
Message Size: No fixed limit - limited by RAM

20 elements/types per message
Customer Memory: 2 megabytes for fonts, images and messages

ProSeries: 12 fonts, 100 bitmaps, up to 2000 average-size labels*
Graphics: 3 fonts, 20 bitmaps, up to 200 average-size labels*
*NOTE: These figures are estimates only; the actual amounts will
vary based on label and font sizes.

Fonts: Bitmapped fonts at various heights and widths
Message Elements: Text

Barcodes
Counters
Date / Time
Bitmaps
Dynamic Image

Text Elements: 256 characters
Barcode Elements: I 2 of 5

Code 128
Counter Elements: Start value

Limit value (maximum or minimum)
Rollover value (after Limit value is exceeded)
Direction - count up or count down
Increment value
Repeat value - number of messages (e.g. pallet counter)

Date / Time Options: Normal
Expiration
Rollover
Expiration + Rollover

Date / Time Formats: YYYYMMDD
DDMMYYYY
MMDDYYYY
YYMMDD
DDMMYY
MMDDYY
MM
DD
YYYY
YY
Day of Week number
Week number
Julian Day number
Month alphabetic string
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Day of Week alphabetic string
HHMMSS - 24 hour, 12 hour, 12 hour with AM/PM
HHMM - 24 hour, 12 hour, 12 hour with AM/PM
HH
MM
SS
AM/PM - alphabetic string
Hour alphabetic string
Shift Code alphabetic string - up to three shift codes
Delimiter may be chosen for numeric values (12:59:59)
Alphabetic values are up to 15 characters
Alphabetic codes for Month, Day, and Hour have two versions
All Formats are available for all Time Options

Bitmaps: May be stretched horizontally with Bold and Width values
Dynamic Image: Not implemented
All Message Elements: Bold (stretch horizontally with additional ink) (except Barcode)

Width (stretch horizontally without additional ink) (except Barcode)
Negative (black/white change)
Invert (top/bottom inversion)
Reverse (left/right reversal)
Horizontal position
Vertical position
Concatenate to previous element
Vertical Align with previous element
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Ethernet Interface
IP Address: Fixed IP address

Dynamic IP address using DHCP

Symbolic Address: Printer ID (includes factory-assigned serial number)
Customer supplied name

Web Browser - Internal HTTP server supports browser pages for:
Status and Indicators for temperature, voltage, ink, etc.

TCP/IP: Interface to support all of the above through TCP/IP messages
Available to any software - editor, controller, reporting

FTP - Internal FTP server to send and receive:
Fonts
Bitmaps
All customer information for backup and restore

Web Browser: Windows 95 - Internet Explorer 5.5 or newer
Other Operating Systems - Internet Explorer 6.0 or newer
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Appendix B: Theory of Operation

The Marksman© Net 
The Marksman© Net controller is based on the NETsilicon Net+Arm chip, which is a chip
that contains a processor, Ethernet MAC and other peripherals required for an embedded
networking application, excluding memory. The other items, memory, real time clock and
driver chips are also included on the board. The Marksman© Net includes three types of
memory, SDRAM which is the system’s memory required for the processor to operate,
Flash memory where messages and the program are stored and SRAM which is battery
backed-up and is used to store the current label and counts. The real time clock/calendar
provide date and time to the system.

The Marksman© Net connects to a standard 10/100 Base-T network where it becomes a
file server that can be used to set up or control the Marksman© Net. Documents on the
Marksman© Net are sent to a client in HyperText Mark-up Language (HTML) format. To
access or view these documents only requires a web browser and a network connection.
To access the Net over a network with a web browser, a valid IP address must be entered
and the user must have a proper networking connection.

Print Heads
The Marksman© Net supports all the Pro series printheads. A typical printhead includes a
reservoir section, drive electronics, and a print engine.   The information and power needed
for printing are sent to the print head through the DB25. The DB9 is used for APS control. 

The drive electronics include a Universal Driver Board and Marksman© Driver Board. The
Universal Board takes 24VDC and generates the high voltage needed by the print engine.
The Marksman© Driver Board (only on UJII engines) converts the serial data from the con-
troller to parallel high voltage data required to control the print engine channels.

The APS includes an ink collection bottle, vacuum pump, APS board, purge pump and res-
ervoir. The APS cycle is controlled by the Marksman© Net via a DB9 cable. Parameters
are set through the software. It is important for the cable to be connected. The power and
low ink signals are sent to the Marksman© Net through the DB25 cable.   The ink collection
bottle stores the used ink from the APS cycles. If the bottle becomes full, or the reservoir is
low, the APS is disabled and the error LED is set.

Photosensor
The photosensor detects a product as it passes in front of the sensor. The signal starts the
printing process. Once the printing process has started it will continue until the label is com-
plete, regardless of what the photosensor signal does.
 

Encoder
The encoder is used to signal the controller when to print another column of ink. There are
two encoder options, external or internal. The external encoder rides on the conveyor to
determine how often to print a column of ink. As the conveyor's speed changes so will the
period of time between the printing of the columns of ink. The internal encoder is timed-
based so that if the speed of the conveyor changes the print will be stretched or com-
pressed until the encoder speed is corrected.
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Interconnect Diagram

2 1 2 1

CABLE, APS PCB TO
PRINT ENGINE OR
DRIVER PC BOARD

DRIVER PC BOARD

RED DOTPRIME PUMP

SEPARATOR

RESERVOIR

APS PCB

CABLE, VACUUM
PUMP TO APS PCB

VACUUM PUMP

CABLE, RESERVOIR
TO APS PCB

CABLE, PRIME
PUMP TO APS PCB

RED DOT

BLACK

RED

BLACK RED

J4



 Appendix C: Parts and SuppliesBoxWriter Net Software

2464-308 User Manual Rev F, Version 3.54 Page 105

Appendix C: Parts and Supplies

Consumables 

Service Kits 

Part Number Description
001-0732-01F Ink, 500mL Bottle, V300 Black

001-0598-01F Ink, ScanTrue II®

032-6001-01 Ink, 500mL Bottle, AlphaMark

2464619 Kit, Ink Waste Bottle, V300 Ink (APS only)

2464620 Kit, Ink Waste Bottle, ScanTrue II® Ink

2464621 Kit, Vent Filter Replacement

X30001-001 Print Head Wiping Cloth (300/pkg)

Part Number Description

2464646 Kit, Marksman Next PCB

5760333 Kit, 24 VDC Power Supply
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Print System Kits 

ITEM NO. PART NO. DESCRIPTION
       1   2464607 Print Engine Kit, 96, V300, APS, w/Tubing & Nose Piece
  2464608 Print Engine Kit, 192, V300, APS, w/Tubing & Nose Piece
  2464609 Print Engine Kit, 352, V300, APS, w/Tubing & Nose Piece

 2464632 Print Engine Kit, 384, ScanTrue II, APS, W/Tubing & Nose Piece
 2464613 Print Engine Kit, 768, ScanTrue II, APS, w/Tubing & Nose Piece
 2464604 Print Engine Kit, 96, V300, Non-APS, w/Tubing & Nose Piece
 2464605 Print Engine Kit, 192, V300, Non-APS, w/Tubing & Nose Piece
 2464606 Print Engine Kit, 352, V300, Non-APS, w/Tubing & Nose Piece
 2464636 Print Engine Replacement Kit, AlphaCoder, ScanTrue II
 2464642 Print Engine Replacement Kit, AlphaMark

       2   2464614 Prime Pump Replacement Kit, V300
 2464625 Prime Pump Replacement Kit, ScanTrue II

       3 & 8   2464615 Reservoir & Ink Line Tubing Replacement Kit, V300
 2464616 Reservoir & Ink Line Tubing Replacement Kit, ScanTrue II
 2464641 Reservoir & Tubing Replacement Kit, AlphaMark

       4   2464617 APS PCB Replacement Kit
       5   2464618 Ink Seperator Replacement Kit
       6   2464619 Ink Waste Bottle Kit, V300 Ink (APS Only)

 2464620 Ink Waste Bottle Kit, ScanTrue II Ink
       7   2464621 Vent Filter Replacement Kit
       9   2464623 Marksman Driver Board Replacement Kit
      10  2464624 Universal Driver Board Replacement Kit
      11         2464120 Communications Cable
      12  2464144 Cable, Driver Board to APS PCB
      13  5760527 Cable, Reservoir to APS PCB
      14  2464146 Cable, Prime Pump to APS PCB
      15  2464147 Cable, Vacuum Pump to APS PCB
      16  2464629 HV PCB Replacement Kit, 384 and 768 Heads only (Not shown)

NOTE:  Please refer to the ProSeries NP192 Manual (2466401) for Service and
  Parts Kits for the NP192 Integrated Print Head.

1

2

3

4

5

6

7

8912

13

10

14 15

11
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Appendix D: Testing the Electrical Outlet

CAUTION: The outlet must be installed near the equipment and must be easily accessible.
ATTENTION: On doit installer à côté de l'appareil une prise de courant facilement accessi-
ble.
Before installing the system, verify the integrity of the 115VAC (US and Canada only)
sourced power, in accordance with the National Electric Code (NEC) (US only) and
approved local electrical codes. If using a standard AC outlet, use the following procedure
to verify the integrity of your outlet.
1. Place an outlet tester into the socket. (You can purchase an outlet tester at most hard-

ware stores).
2. If the outlet tester indicates that the outlet is wired correctly, proceed with the installa-

tion.   
3. If the outlet tester indicates that the outlet is wired incorrectly, inform plant maintenance

immediately and do not use the outlet until it has been re-wired. 

Electrical Line Transients

Transients on the incoming AC power line can be in the form of voltage spikes and tran-
sients, over- and under-voltage events, or noise caused by poor grounding or interference.
Symptoms of power related problems can be unexplained loss of controller memory (loss
of message), garbled print, and unexplained hardware resets. 
The best way to eliminate these types of problems is to install the controller on a dedicated
line with a line conditioner. A dedicated line refers to an AC line that only the system com-
ponents are plugged in to. This is most effective when the source is at the building main
service entrance. 
Good quality line conditioners will provide protection against all AC line problems with the
exception of power outages; if power outages are a problem at the installation, an uninter-
ruptible power supply (UPS) should be installed. 

CAUTION: Not for use in a computer room as defined in the Standard for the Protection of
Electronic Computer/Data Processing Equipment, ANSI/NFPA 75 (US and Canada only).
ATTENTION: Ne peut être utilissé dans une salle d'ordinateurs telle que définie dans las
norme ANSI/NFPA 75 Standard for Protection of Electronic Computer/Data Processing
Equipment.
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Appendix E: Setting the IP Address

Setting the IP Address on the Controller
To set the Marksman© Net’s IP address, the Marksman© Net has to be connected to a
computer via the serial port. This is done using a DB9 straight-through cable connecting
the serial port on the Marksman© Net to an open serial port on the computer. (If the Con-
troller does not connect, review Section 10: Troubleshooting.) Once properly connected,
complete the following steps:
• Open Hyper Terminal.
• Configure Hyper Terminal to:

Baud rate=38400, Data Bits=8, Parity =None, Stop Bits=1, Flow Control = None.
• Power up Marksman© Net.
• Follow the commands to change the IP address.

Connect the MK Next to a serial port on a computer to set the IP address. The default IP
address is 10.1.2.100. The following was done using HyperTerminal: 

Default serial port settings:
Baud rate: 38400
Data bits: 8
Parity bits: none
Stop bits: 1

When the serial port is configured and connected, apply power to the MK Next to start the
set up. The following will appear if everything is set-up properly.
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Press any key in five seconds to change these settings. Press a character to enter set-up.

Press A to Accept the settings, or M to Modify? M <Enter>

Enter the root password: password <Enter>

Reset configuration to default values [N]? n<Enter>

For each of the following questions, you can press <Return> to select the value shown in 
braces, or you can enter a new value.

ETHERNET INTERFACE SETTINGS:
Obtain IP settings automatically using DHCP for Ethernet interface [N]? <Enter>

IP address [10.1.2.100]?
Subnet mask [255.255.255.0]?
Gateway address [10.1.2.1]?

Enable DHCPv6 for the Ethernet interface [N]? <Enter>

Enable static IPv6 for the Ethernet interface [N]? <Enter>

Ethernet duplex setting (default, full, half)? [default] <Enter>

SERIAL CONSOLE PORT SETTINGS:

Set the baud rate of the serial console port [38400]? 
    9600, 19200, 38400, 57600, 115200 <Enter>

SECURITY SETTINGS:

Would you like to update the Root Password [N]? <Enter>
Would you like to update the Administrator 'admin' Password [N]? <Enter>

MISCELLANEOUS SETTINGS:

How long (in seconds) should CPU delay before starting up [5]? <Enter>

Saving the changes in NV memory...Done.
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Setting the IP Address on the Computer
This section has instructions for setting the IP address and subnet mask of the PC so it can
communicate with the Marksman© Net Controller. The instructions are for Windows XP®. 

1. Open the Start menu; select Settings, then Network Connections. 

2. Right click Local Area Connection, then open the File menu and select Properties.
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3. Select Internet Protocol
(TCP/IP) then click the
Properties button. 

4. Click the Use the fol-
lowing IP address radio
button. Enter an IP
address of 10.1.2.4, a
subnet mask of
255.255.255.0, and click
the OK button. 
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Appendix F: Fonts

Following is a list of available fonts. (Contact the Distributor for special fonts, special char-
acters or new fonts.) 

Arial Regular Times New Roman Italic
ArialReg24 TimesIt24
ArialReg32 TimesIt32
ArialReg48 TimesIt64
ArialReg64 TimesIt96
ArialReg96 TimesIt128
ArialReg128

Miscellaneous (ProSeries 96, 152 
Arial Bold and 352 fonts)
ArialBold24 fx5x6
ArialBold32 fx7x6
ArialBold64 fx10x10
ArialBold96 fx12x12
ArialBold128 fx16x8

fx16x10
Times New Roman Regular fx16x12
TimesReg24 fx16x16
TimesReg32 fx32x22
TimesReg48 fx32x24
TimesReg64 fx32x24bold
TimesReg96 fx32x32
TimesReg128
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Font Samples 
The following samples are for a ProSeries 768 Print Head with a Bold of 0 and a Width of 1
at 300 dpi.

Arial Bold 128: 

Arial 128: 

Arial Bold 96: 

Arial 96: 
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Arial Bold 64: 

Arial 64: 

Arial Bold 32: 

Arial 32: 

Arial Bold 24: 

Arial 24: 
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Times New Roman 128: 

Times New Roman Italic 128:

Times New Roman 96: 

Times New Roman Italic 96: 
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Times New Roman 64: 

Times New Roman Italic 64: 

Times New Roman 48: 

Times New Roman 32: 

Times New Roman Italic 32: 

Times New Roman 24: 

Times New Roman Italic 24: 
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Appendix G: Standard Operating Procedures

FJSOP1 - Removal of FoxJet High Resolution Printheads
PURPOSE: To detail the procedure for removing a Foxjet High-Resolution inkjet

printhead from a production line.

RESPONSIBILITY: Customer or authorized FoxJet Distributor technician.

SAFETY: All personnel performing this procedure must wear proper eye pro-
tection and latex gloves.

FREQUENCY: Each time a printhead is to be removed from a production line.

PROCEDURE:

1. Initiate the proper controller shutdown procedure, TURN OFF AND UNPLUG THE
CONTROLLER from electrical power source to avoid possible electrical problems and/
or electric shock.

2. Disconnect all printhead cables from the controller.

3. Remove the ink bottle and install the Res-
ervoir Ship Cap. 

4. Remove vent cap filter (if applicable) and
close the vent cap.

5. For an AMS/APS system, remove Waste Ink Bottle
and reinstall the Short Black Protective Shipping
Bottle. 

6. Install the faceplate cover on the front of the print-
head (when properly installed it should cover the
CP/OP). 

7. Insure that all printhead covers are properly installed, clean and all screws are in place.
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8. Remove all photocell and photocell brackets from the printhead, if applicable.

9. Remove screws that hold the printhead to the bracketry.

10. Wrap a clean shop cloth around the front of the printhead to catch any ink that may leak
out and secure the cloth with masking or packing tape.

11. Place a plastic bag over the printhead assembly and secure it with tape. 

12. If the printhead is to be stored for later use, it should be stored in a cool, dry location.

13. If the printhead is to be shipped, it should be well padded and packed in its original
shipping box. 

CAUTION:

Observance and practice of this procedure is critical to insure no damage occurs during
shipping. 

FoxJet will replace, and charge for, any items found to be missing before it can be returned.

FoxJet may deny warranty coverage if the printer or part has failed as a result of abuse, ne-
glect, improper maintenance, improper shipping, or unapproved modification(s). Please re-
fer to the Master Warranty Statement.

END

!
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FJSOP2 - Daily Maintenance for AMS/APS Printheads
SCOPE: All AMS/APS (Automatic Priming System) Printheads.

PURPOSE: Detail the procedure for performing the required maintenance
routine for Foxjet AMS/APS High-Resolution inkjet printheads.

RESPONSIBILITY: Customer.

SAFETY: All personnel performing this procedure must wear proper eye pro-
tection and latex gloves.

FREQUENCY: This procedure is to be performed daily, or as often as required,
depending on print quality.

PROCEDURE:
1. Using a lint-free Texwipe, carefully clean any corrugated dust, hot melt glue strings and/

or other debris from the CP/OP area. Be sure to wipe across the CP/OP in one direc-
tion, NOT UP AND DOWN OR BACK AND FORTH, to lessen the likelihood of debris
being pushed into the orifices. Failure to wipe in the appropriate direction will damage
the CP/OP.

2. Press and release the purge button to initiate an automatic prime/purge cycle (observe
that the ink is vacuumed off the CP/OP).

3. Wipe across the CP/OP with a lint-free Texwipe in one direction to remove excess ink,
if necessary.

4. Verify that all screws are in place and that covers are clean and properly installed.

5. Insure that the front of the printhead is parallel to, and within 6mm (0.25") or less, of the
side of the carton as it passes in front of the printhead.

6. Insure that the conveyor guides are adjusted to prevent cartons from contacting the
printhead.

7. Run a print sample to ensure all the channels are printing and producing good print
quality. 

IF PRINT QUALITY IS ACCEPTABLE, PROCEED NO FURTHER.
8. If there are several channels not printing, take several lint-free Texwipes and press

them against the front of the CP/OP to catch the ink during the next step in the mainte-
nance process.

9. Press and hold the purge button for three to four seconds to prime the system or purge
air from the printhead.
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10. Spray the proper maintenance fluid, as identified below, on a dry wipe card or folded
Texwipe.

10.1 For Printheads using VersaPrint ink, use FoxJet P/N X31003-001 spray.

10.2 For Printheads using ScanTrue II ink, use FoxJet P/N X31027-001 spray.

11. Wipe across the CP/OP with the wipe card or lint-free Texwipe to remove any excess
ink and/or maintenance spray.

12. Run a print sample to ensure all the channels are printing and producing good print
quality. 

IF PRINT QUALITY IS ACCEPTABLE, PROCEED NO FURTHER.
13. If there are any channels that still do not print, repeat steps 8 through 12 as required.

Replacing APS waste ink bottles

FoxJet APS systems have waste ink catch bottles installed to the rear of the printhead/ink
system and employ a waste ink detection circuit to disengage the APS feature when the bot-
tle becomes full. Failure to replace a full waste ink bottle will disengage the APS system.

To maximize equipment longevity and increase performance, preventive maintenance rou-
tines must be performed on pre-defined daily, weekly, and/or monthly schedules.

If performing these measures is not already a regular practice, it should be immediately es-
tablished as a top priority to prolong the life of the system.

FoxJet may deny warranty coverage if the printer or part has failed as a result of abuse, ne-
glect, improper maintenance, or unapproved modification(s). Please refer to the Master
Warranty Statement.

END
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FJSOP3 - Daily Maintenance for non-AMS/APS Print-
heads

SCOPE: All non-AMS/APS (Automatic Priming System) Printheads.

PURPOSE: Detail the procedure for performing the required maintenance
routine for Foxjet non-AMS/APS High-Resolution inkjet print-
heads.

RESPONSIBILITY: Customer.

SAFETY: All personnel performing this procedure must wear proper eye pro-
tection and latex gloves.

FREQUENCY: This procedure is to be performed daily, or as often as required,
depending on print quality.

PROCEDURE:
1. Using a lint-free Texwipe, carefully clean any corrugated dust, hot melt glue strings and/

or other debris from the CP/OP area. Be sure to wipe across the CP/OP in one direc-
tion, NOT UP AND DOWN OR BACK AND FORTH, to lessen the likelihood of debris
being pushed onto the orifices. Failure to wipe in the appropriate direction will damage
the CP/OP.

2. Fold 2 Texwipes over and hold them against the face of the printhead to catch the ink
during the next step in the maintenance process. 

3. Press and hold the priming button for three to four seconds to prime the system or
purge air from the printhead.

There are two types of Non AMS/APS Heads on the Market:

A: With a motorized priming pump and button to energize it.

B: With a prime bulb mounted to the rear of the Print Head Assembly. With this
type printhead, only push the bulb in. Do not squeeze or pinch the bulb, which
can damage the bulb and/or the valve internal to it.

4. Wipe across the CP/OP in one direction with a lint-free Texwipe to remove excess ink.

5. Verify that all screws are in place and that printhead covers are clean and properly
installed.

6. Insure that the front of the printhead is parallel to, and within 6mm (0.25") or less, of the
side of the carton as it passes in front of the printhead.

7. Insure that the conveyor guides are adjusted to prevent cartons from contacting the
printhead.
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8. Run a print sample to ensure all the channels are printing and producing good print
quality. 

IF PRINT QUALITY IS ACCEPTABLE, PROCEED NO FURTHER.

9. If there are several channels not printing, fold two Texwipes over and hold them against
the face of the printhead to catch the ink during the next step in the maintenance pro-
cess.

10. Press and hold the priming button for a maximum of five seconds to prime the system
or purge air from the printhead.

11. Spray the proper maintenance fluid, as identified below, on a dry wipe card or folded
Texwipe.

11.1. For Printheads using VersaPrint ink, use FoxJet P/N X31003-001 spray.

11.2. For Printheads using ScanTrue II ink, use FoxJet P/N X31027-001 spray.

11.3. For Printheads using AlphaMark ink, use Ethyl Alcohol (commercially available).

12. Wipe across the CP/OP with the wipe card or folded Texwipe to remove any excess ink
and/or maintenance spray.

13. Run a print sample to ensure all the channels are printing and producing good print
quality. 

IF PRINT QUALITY IS ACCEPTABLE, PROCEED NO FURTHER.

14. If there are any channels that still do not print, repeat steps 8 through 12 as required.

Maintenance Requirements

To maximize equipment longevity and increase performance, preventive maintenance rou-
tines must be performed on pre-defined daily, weekly, and/or monthly schedules.

If performing these measures is not already a regular practice, it should be immediately
established as a top priority to prolong the life of the system.

FoxJet may deny warranty coverage if the printer or part has failed as a result of abuse,
neglect, improper maintenance, or unapproved modification(s). Please refer to the Master
Warranty Statement.

END
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FJSOP4 - Installation of FoxJet High Resolution AMS/
APS Printheads

PURPOSE: Detail the procedure for installing a FoxJet AMS/APS high-resolution
inkjet printhead onto the production line.

RESPONSIBILITY:  Customer or Distributor.

SAFETY: All personnel performing this procedure must wear proper eye pro-
tection and latex gloves.

FREQUENCY: Every time a printhead is installed on the production line.

PROCEDURE: 
1. Remove packing materials and retain for possible future use.

2. Insure that all printhead covers are properly installed, clean and all screws are in place
and tight. 

3. Position the printhead and install the screws that hold the printhead to the printhead
bracketry.

4. Adjust bracketry so that the front of the printhead is parallel to, and no more than 6mm
(0.25”) away from, the side of the carton as it passes in front of the printhead.

5. Insure that conveyor guides are adjusted so that the cartons CANNOT hit the print-
head.

6. Remove the Reservoir ship cap and install the ink bottle (insure the expiration date on
the ink bottle has not yet occurred).

7. Open the vent cap and install a clean vent cap filter (FoxJet PN X40119-001).

8. If not installed, install an ink waste bottle (FoxJet PN X01240-002).

9. Remove the faceplate cover from the front of the printhead (Save the faceplate cover
and Reservoir ship cap for use when you remove the printhead from the production
line).

10. Switch controller power OFF. 

11. Unplug controller from power source, if applicable.

12. Connect the printhead cable to the controller. 

13. Connect the photocell cable to the printhead, if applicable.

14. Plug the system into a dedicated source of clean electric power.

15. Turn the power on to the printhead and wait for it to heat to temperature, which should
take approximately five to ten minutes. (A Marksman Net or UJII 352/32 Printhead may
take up to 30 minutes. On Marksman Net and Marksman Pro Series controllers, it may
take approximately 30 minutes to bring a ProSeries printhead to the appropriate tem-
perature.)
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16. Take several lint-free Texwipes and press them against the front of the CP/OP to catch
any ink.

17. Press the purge switch for three to four seconds to purge any air out of the system.

18. Spray the proper maintenance fluid, as identified below, on a dry wipe card or folded
Texwipe.

18.1 For Printheads using VersaPrint ink, use FoxJet P/N X31003-001 spray.

18.2 For Printheads using ScanTrue II ink, use FoxJet P/N X31027-001 spray.

19. Momentarily press the purge switch to initiate an automatic prime/purge cycle. 

20. Wipe across the CP/OP with the wipe card or lint-free Texwipe to remove any excess
ink and/or maintenance spray.

21. Run a print sample to ensure all the channels are printing and producing good print
quality. 

IF PRINT QUALITY IS ACCEPTABLE, PROCEED NO FURTHER.

22. If all channels are not printing properly, repeat steps 16 through 21. If the printhead has
not been in use for several months, it may take 30+ minutes for all channels to print.

END


